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CallPilot Unified Messaging 

Overview  

CallPilot Unified Messaging is a multimedia messaging application that works 
with e-mail clients to provide a single interface for your email messages, 
CallPilot voice and fax and text messages.  

Required Information 

 The IP address of the BCM system, if DNS is not being used. 
or 

 The fully qualified domain name (FQDN), if DNS is being used. 

 If Message Networking (VPIM / AMIS) is configured, the SMTP/VPIM 
prefix is required. 

 The subscriber‟s mailbox number. 
 
Before you install CallPilot Unified Messaging on a subscriber‟s computer: 
 

 Make sure the subscriber‟s computer has the correct hardware and 
software requirements. Refer to Hardware Requirements and 
Software Requirements sections of this guide. 

 Ensure that the microphones, speakers, and sound cards that are 
connected to the subscriber‟s computer are configured. Refer to the 
manufacturer‟s documentation. 

 If the subscriber wants to send or receive faxes on their computer, 
ensure that they have the ability to view Fax attachments. 
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Hardware Requirements 

The following list contains both the minimum and recommended hardware that 
Unified Messaging software needs for operation: 
 

 IBM PC or compatible: minimum Pentium/586 or faster system with 16 
megabytes (MB) of RAM minimum; 32 MB recommended. 

 

 Monitor:16-color VGA 640 x 480 capability minimum; 256-color SVGA 
800 x 600 capability recommended. 

 

 Disk drive space: To install Unified Messaging, subscribers need 110 
MB of disk space. After the installation is complete, the temporary files 
are automatically deleted to recover 55 MB of disk space. You or the 
subscriber must manually delete the CallPilotDesktopMessaging.exe 
file to recover the additional 55 MB. The.exe file is located where you 
downloaded it. 

 

 CD-ROM drive. 
 

 Windows-compatible mouse and keyboard. 
 

 LAN connection to Business Communications Manager. Subscribers 
can access their CallPilot messages over the LAN through ISDN, 
ADSL, dial-up modem or Ethernet. 
 

 

Optional Hardware 

 A sound card and a set of speakers (or headphones) for playing 
messages on a computer. 

 

 A microphone for recording messages on a computer. 
 

Unified Messaging Clients 

The maximum number of Unified Messaging clients supported on the 
BCM450 is 300. The maximum number of clients supported on a BCM50 is 
50. 
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Software Requirements 

Supported Integrated Clients 

Unified Messaging supports the following integrated e-mail clients:  
 

 Microsoft Outlook 2002 (XP), 2003, 2007 

 Lotus Notes - 6.0, 6.5, 7.0, 8.0.0, 8.0.1, 8.0.2, 8.5  

 GroupWise - 6.5, 7.0, 7.0.1 (except on Windows Vista) , 8.0  
 

Supported Internet Mail Clients 

Unified Messaging also supports the following internet Mail Clients: 
 

 Microsoft Outlook Express - 6.x.  

 Windows Vista Mail.  

 Microsoft Outlook 2002 (XP), 2003, 2007, all in Internet Mail Mode. 
 

Note: CallPilot Desktop Messaging does not support Outlook and GroupWise 
on the same PC. 

Supported Thin Clients 

 Citrix Metaframe XP on Windows 2003 Server (all editions). 

 Citrix Metaframe Presentation Server 3.0 on Windows 2003 Server (all 
editions).  

 Citrix Metaframe Presentation Server 4.0 on Windows 2003 Server (all 
editions).  

Supported Operating Systems 

 Windows XP Professional SP3.  

 Windows Vista Business, Ultimate, Enterprise SP2 32/64 bit. 

 Windows 7 32/64 bit. 
 

Supported Browsers 

 

 Internet Explorer 6.0, 7.0, 8.0. 
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Flowchart 
 
The following Flowchart depicts the correct steps to install, configure and test 
the CallPilot Unified Messaging application. 
 

 
 
 
 
 

Obtain the required information: Refer to 
the Required Information section of this 
guide 

Check the email client to be used is working 
correctly. 

Download CallPilot Unified Messaging from 
the BCM Web page: Refer to the Installing 

Unified Messaging section of this guide. 

Login to CallPilot Unified Messaging: Refer 
to the Logging into CallPilot Unified 
Messaging section in this guide 
 

Create a Voice Message addressed to the 
DN that has been configured in Unified 
Messaging: Refer to the To Play a Voice 
Message section in this guide 
 

Check that the 
message appears in 
the CallPilot Message 
Store‟s Inbox, or 
regular Inbox 
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Before Installing Unified Messaging 

 In Element Manager, enable the Unified Messaging software 
authorisation code and optionally the Fax keycode. For information on 
enabling on enabling software authorisation codes, refer to the CallPilot 
Manager Set Up and Operation Guide. 

 

 In CallPilot Manager, ensure that the number of Maximum Out calling 
Channels is enough to accommodate the expected CallPilot telephone 
player usage. This value governs the number of simultaneous channels 
used for out calling. For information on setting the out calling channels, 
refer to the CallPilot Manager Set Up and Operation Guide. 

 

Note: The following installation procedure details the steps required to install 
Desktop Messaging onto a Windows XP machine using Microsoft Outlook as 
the default e-mail client. 

 

Installing Unified Messaging 

 
1. Open Internet Explorer.In the address field type (replacing the relevant 

part with your BCM IP address): http://<bcm ip address>/   
 

 
 

2. Click on Go, or press Return on your keyboard.  
 

Note: You can also use the Web Page button in Element Manager to launch a 
web broswer session. The BCM you wish to access must be selected in the 
Element Navigation Panel to do this. 
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3. If you are presented with the Certificate Error window, click on 
Continue to this website (not recommended). 

 
 

4. Accept any further security messages that you may get presented with. 
 

 
 

5. You will now see the login screen, enter your BCM User name and 
Password. By default these are set to User ID: nnadmin Password: 
PlsChgMe! Click on OK. 
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6. In the Welcome to BCM window, ensure the Main tab has been 
selected, and the BCM button clicked. 

 

 
 

7. In the Applications area, select User Applications,and click on Run. 
 

 
 

8. Again, accept any security messages that appear, and if prompted 
enter any login details. 
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9. You will be presented with the User Applications screen. Click 
CallPilot Unified Messaging. 

 

 
 

10. Then click the CallPilot Unified Messaging link for the installation 
language type that is required. 
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11. The File Download dialogue box appears. 

 

 
 

12. Click Run. 
 
13. Unified Messaging downloads to the subscriber‟s computer. The 

following screen will appear as the application downloads. 
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14. Click Run again. 
 

 
 

15. The files will be extracted. 
 

 
 

16. Click Next on the InstallShield Wizard screen. 
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17. The Server Information & Language selection screen appears. Enter 
the location of your BCM, either as it‟s IP address or Fully Qualified 
Domain Name, and select the desired language. Click Next when the 
details have been entered. 

 

 
 

Note: If CallPilot Networking is not enabled on the Business Communications 
Manager system, leave the VPIM Network Prefix box blank. Otherwise use 
the value defined in the Local Prefix field in the Digital Networking Properties 
page in CallPilot Manager. 

 
18. Select the Setup type and click the Next button. 
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19. The application is now ready to install. Click the Install button to 

proceed. 
 

 
 

20. During installation, the application will automatically detect any of the 
Supported Integrated Email clients to configure. 

 

Note: CallPilot will automatically configure any of the supported default 
email clients during installation. If the email client is not installed or 
configured the following message may appear. 

 

 
 
The application will still install but will require the setup/ configuration of the 
email client to complete the process. 
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21. The progress window will appear whilst the application is installing. 
Once completed, the InstallShield Wizard Completed window will 
display. Click Finish to comlpete the installation.  

 

 
 

Setting the Default Email Client 

After you install Unified Messaging, you must set (or check) the default email 
client. 
 

1. Click the Windows Start button, point to Settings and click Control 
Panel. 

 
2. The Control Panel window appears. 
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3. Double click the Internet Options icon. 

 
4. The Internet Properties window appears. 

 

           
 

5. Click the Programs tab.  
 

       
 

6. In the E-mail list box, make sure the client that is displayed is the e-
mail client you are using, for example Microsoft Outlook. 

 
7. If another email client is displayed, select the correct email client from 

the E-mail list box. 
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8. Click the OK button. 

Logging into CallPilot Unified Messaging 

1. Open your email client. The CallPilot Login window will appear. Enter 
the required mailbox number. 

 

 
 

2. In the CallPilot Logon window, type your CallPilot password in the 
Password box. You can also tick the Remember password checkbox 
so that you won‟t have to enter the password again. Click OK when you 
have entered the information. 

 

Note: If the Remember password check box is selected any future 
attempts to login into Unified Messaging will bypass the CallPilot Logon 
screen. Therefore to change audio settings previously available from the 
Configuration button illustrated above, please refer to the Changing your 
Default Audio Device and Telephone Number section of this guide. 

 
3. You will be presented with the delivery option box. You can select 

where your CallPilot messages are stored. Select youir delivery 
preference from the drop-down list, and click OK. 
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4. Click the Download now button. This will download a list of all the 

mailboxes that are created on the BCM, for addressing purposes. 
 

 
 

5. When all the entries in the address book have been downloaded, click 
OK. 

 

 
 

6. Your e-mail client will continue to load in the usual manner. 
 

CallPilot MWI Configuration 

You can access the CallPilot MWI Configuration by right clicking on the phone 
icon (in the system tray) and selecting CallPilot MWI Configuration. This will 
give you limited access to the General Configuration tab of Unified 
Messaging.  

 

 
 
 
 
 
 
 
 
 

Attribute Description 

CallPilot Inbox Adds an additional Inbox to your email client, separating 
your CallPilot messages. This will appear as CallPilot 
Desktop Messaging in your Email client. 

E-mail Inbox Sends any CallPilot messages to your regular E-mail Inbox. 
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General Tab. 

 
 
This screen contains the following information/ options:  

 

Attribute Description 
Server (Read only) contains the IP address of your 

BCM 

VPIM Network Shortcut (Read only) enter your VPIM network 
shortcut (if required) 

Mailbox (Read only) enter your mailbox/extension 
number 

Password Enter your mailbox password 

Remember Password Tick to store your password for future use 

Change Password Use this option to change the mailbox 
password 

Advanced Lets you specify an IMAP port and select 
whether to use SSL security. 

My CallPilot URL Displays your MailboxManager URL 

Notify me if CallPilot URL changes Tick to enable notification of URL changes 

Show MWI (Message Waiting 
Indicator) icon on taskbar 

Tick to display the MWI icon on the taskbar 

Display pop-up balloon for 5 seconds Depicts the time (in seconds) that the 
notification pop-up balloon is displayed for 

 

Note: To access all features, including the ability to change the Server, VPIM 
Network and Mailbox – see the Accessing the CallPilot Desktop 
Messaging Properties section of this guide. 
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Accessing the CallPilot Desktop Messaging Properties 

You may wish to change certain attributes of the CallPilot application. You can 
do this from the CallPilot Desktop Messaging Properties screen. To access 
this, follow the steps below. 
 

1. Within Outlook select the Tools menu, and then select the CallPilot 
Desktop Messaging option. Click on Configuration. 

 
 

            
 

2. In more recent versions of Outlook (e.g. Outlook 2007), the 
Configuration options box can be accessed by navigating to Add-Ins, 
CallPilot Desktop Messaging, Configuration. 

 

 
 
 

Note: These settings can also be accessed from the Logon screen (unless the 
Remember Password option has been selected). 

 
 

3. You can now navigate by simply clicking on the tabs at the top of the 
properties box. 
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The General Tab 
 

 
 

 
Use this tab to provide the following information: 

 
 Server: The domain name or IP Address of the BCM. 

 
 VPIM network shortcut: If using Message Networking, this is the 

Message Networking VPIM ID that appears in front of the mailbox 
number.  

 
 Mailbox: The mailbox number that Unified Messaging logs on to. 

 

 Password: Password associated with the mailbox. 
 

 Remember password: Tick this box so that you are not presented with 
the CallPilot logon box when your email clients loads. 
 

 Change password: Click this box to change the password for your 
mailbox. This also affects the password entered when logging on to a 
mailbox via a telephone. 

 
 My CallPilot URL: Displays the path to the Mailbox Manager web 

application. This path will be activated when selecting Open 
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MyCallPilot… from the system tray icon. You can also choose to be 
notified if the URL for CallPilot specified on the server changes. For 
more information on MailboxManager, refer to the CallPilot Manager 
and Mailboxes Guide. 

 
 Instant Messaging Applications: Select to use an Instant Messaging 

application for real time text chat, from a CallPilot message. 
 

The Mail Tab 
 

 
 
 Deliver to: Select whether to store CallPilot messages in their own 

Inbox, or merged with emails in your current Inbox. 
 

 Convert incoming voice messages to WAV: This option can only be 
changed when CallPilot messages are delivered directly into your 
existing mailbox. 

 
 Notification: Defaults to Automatically allowing the application to 

contact the server and notify of new messages as and when needed. 
 

 Use CallPilot form: Check this box to display CallPilot messages 
using the CallPilot custom form instead of the standard Outlook form. 
The CallPilot custom form provides one-click playback of CallPilot voice 
messages (including a default „Compose‟ and „Forward/Reply‟ forms). 



CallPilot Unified Messaging 

26  NN40011-019 Issue 1.2 BCM Rls 6.0 

 
 Include Message Header when forwarding or replying: If checked, 

text message headers are copied into forwarded messages and 
replies. If cleared, text message headers do not appear. Default is 
cleared. 

 
 Include Cover Page when Forwarding FAX: Stipulates the cover 

page template to be used for Fax forwarding. 
 Convert voice messages to WAV for non-CallPilot recipients: 

Select this option to automatically convert voice messages to WAV 
format when you e-mail them to non-CallPilot users. 

 
 Check Spelling before Sending: Tick this option to invoke the 

spellchecker. 
 

 Show message waiting indication on task bar: Select this option to 
display the Message Waiting Indicator (MWI) on the Windows task bar. 
The MWI turns red when you receive new messages, and provides 
status information about your CallPilot mailbox. 

 
 Personal Folders: Opens the Microsoft Personal Folders dialogue 

box, where you can configure Microsoft Options. 
 

 Advanced: Change CallPilot IMAP and SMTP port settings.  
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The Address Book Tab. 
 

 
 

 

Use the Address Book tab to download the CallPilot Address Book from the 
server. This Address Book contains the names and addresses of all users on 
your CallPilot system (BCM).  

 
 Path: Displays the path of the local CallPilot address book. 

 
 LDAP Search Base: The search base for the CallPilot directory on the 

CallPilot server. The search base must be set correctly to download the 
CallPilot Address Book.  

 
 Order: Specify whether names in the CallPilot Address Book are 

organized by first or last name. 
 

 Notify me of LDAP search base changes: Check this option to 
receive notification when the search base defined on the CallPilot 
server changes. Feature availability: This feature is only available if 
your company‟s LDAP server is located on a CallPilot 2.0 server. 

 
 Search Server Address Book: Select this option to use the CallPilot 

address book on the CallPilot server. By accessing the CallPilot 
address book on the server, you ensure that your address information 
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is always up-to-date and does not use up additional disk space on your 
computer. You must be connected to the network to use this option.  

 
 Download Server Address Book to the Local Address Book: This 

option lets you access the address book when you are not connected 
to the network (working offline). To keep the address book up-to-date, 
download the address book regularly. 

 
 Remind me to download address book every xx Days…. Specify 

how often you want to receive a reminder to download your address 
book. 

 
 Use Local CallPilot Server only: Select to search only the local 

CallPilot Server address book. 
 

 Download Now: Manually download the CallPilot Address Book. 
 

 Advanced: Change CallPilot LDAP server and port settings. 
The Audio Tab. 
 

 
 

To play voice messages using the computer, you must have a sound card and 
speakers. To record voice messages using your computer, you must have a 
microphone. 
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Device options: 
 

 Telephone: If selected, indicates that you want to listen to voice 
messages from your telephone. Default: Not selected. The Volume 
control in CallPilot Player is not active if you are using the telephone to 
listen to your messages. 

 
 Telephone Number: The telephone number to use for telephone 

playback. Select a number from the list, or type a number in the format 
that you use to dial it from your telephone. 

 
 Computer: If selected, indicates that you want to listen to voice 

messages from your computer. You must have a sound card and 
speakers. 

 
 Remove: Remove the number in the Telephone number box so that 

you cannot use it for telephone playback. 
 

 Volume: Specify the volume for playing voice messages or recording 
new ones through the microphone. To use the CallPilot system volume 
settings, select the check boxes. To adjust the current volume setting, 
clear the check boxes and adjust the sliders as required. 

 
 Confirm settings before playing or recording: Display the options in 

this dialogue box to confirm settings before playing or recording voice 
messages. Default: Cleared. 

 
 Download File before playing: By default, desktop messaging does 

not automatically download voice messages before playing them 
because voice files tend to be large. 
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CallPilot Desktop Messaging Interface 

When you open youir e-mail client, your CallPilot messages appear in the 
Inbox under CallPilot Desktop Messaging, or in your regular Inbox depending 
on which option you selected when first logging in. From the Inbox, you can 
open, move, copy, delete, forward, and reply to messages, and compose new 
messages. 
 

 

Composing Messages 

You can compose a message that is any combination of voice, fax, or text. A 
composed message can be a new message, a reply to a received message, 
or an introduction to a forwarded message. Before you send a message, you 
can add attachments and options. 

To Record and Send a Voice Message 

You create a voice message by opening a new CallPilot message and 
recording a message from your computer or your telephone. You can send 
the message or save it to send later. A new message can be created from the 
Tool Bar Icon or from the Choose Form Window. 
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To create a new message from the Tool Bar Icon: 
 

1. From the Tool Bar select the new message icon. 
 

            
 

 
 Or, on later versions of Outlook 
 

  
 

2. A new message window will be displayed. 
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3. Choose to record via a telephone or your PC speakers. 
 

 
 

4. On the CallPilot Player, click the red Record button to start recording. 
 

 
 

5. You will hear a tone. Speak into the computers microphone to record 
the message. 

 
6. If you are recording from the telephone, answer when it rings. At the 

tone, record your message.  
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Note: You cannot change your recording device during the creation of a 
CallPilot message. 

 
7. Click Stop to end the recording, and then hang up. 

 

 
 

8. Click To… to open the CallPilot Address Book. 
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9. You may wish to select which Address Book to use. 
 

 
 
10. Select the name of the person(s) you wish to send the message to, and 

click To. Their name will now appear in the To list of the Select Names 
window.  

 

 
 

11. Click OK. 
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12. Enter a subject for the message in the Subject text box. 
 

 
 

13. If you wish to include a text message with the voice message, select 
the Text Message icon and type your message in the Text window. 
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14. To send the message, click the Send Message icon. 
 

 
 
15. The recipient will receive the message and will be able to listen to and 

view the contents as attachments. 
 

To Play a Voice Message 

1. To open a voice message, double-click the message line within the 
CallPilot Message Store Inbox, or in your regular Inbox dependant on 
your delivery options.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. When you open a voice-only message, the CallPilot Player appears 
right away. In mixed voice and fax or text messages, click the Voice 
icon to open the CallPilot Player. 

 

3. You can choose to play your voice messages from your telephone or 
your computer by clicking the Telephone or Computer icon in the 
CallPilot Player. You can change this selection at any time.  
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4. If you select Telephone, the phone rings when you open a message, 
and the message plays when you answer.  

 
5. If you select Computer, your messages play through your computer‟s 

speakers or your headphones. 
 
Voice Message: 
 

 
 

Voice and Text Message:  
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Adding Attachments to Messages 

Before sending a message, you can attach a voice, fax, or text file to it.  
 

Note: Voice files can be .vbk or .wav format for CallPilot recipients, but must 
be .wav format for non-CallPilot recipients. Fax files must be .tif type format. 
Text files must be .txt format. 

 
1. In a new CallPilot voice message, click the Attach File icon.  
 

 
 

2. In the Open File box, select or type the name of the file that you want 
to attach. 

 

 
 
3. Click Open to attach the file and return to the new CallPilot message. 
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4. The contents of the file will appear in the Text Window. 
 

 
 
5. Enter an address and send the message. 

To Create and Send a Fax Message 

To send a fax, your CallPilot mailbox must have fax capability. The recipients 
of your fax must also have fax capability to view the fax on their computer. If 
your recipients access their messages from their telephone, they can view the 
fax only by printing it. Alternatively the fax can be sent directly to a fax 
machine. 
 

1. Open the document that you want to fax. It must be 8.5 inches (21.5 
cm) wide or less.  

 
2. Select the Print option in your program. 
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3. From the list of printers, select CallPilot Fax, then click Print or OK. 

 

 
 

4. Click the Print button. The Compose Fax dialogue box displays.  
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5. To send your fax to a fax machine select Fax Machine from the Send 
Using drop down box. 

 
6. Enter the number(s), in the Fax Machines box and give the fax a 

Subject if required. 
 

            
 

7. If you wish to use a cover page for the fax click on the Use Fax Cover 
Page drop down box and select cover. tif.  
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8. You can then browse for a specific cover page by selecting the Browse 
button. 

 

      
 
 

9. Or you can select Modify to modify an existing cover page or create 
your own cover page. 

 

 
 
 
 
 
 

 



CallPilot Unified Messaging 

NN40011-019 Issue 1.2 BCM Rls 6.0  43 

10. The cover page can be previewed by clicking the Preview button. 
 

 
 

11. Click Close and then OK. You will be presented with the Compose 
Fax window. Click Send. 
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12. To send your fax to a CallPilot or e-mail recipient, select CallPilot 
Desktop Messaging for Outlook from the Send Using drop down box.  
Send using... radio button, then click Send. 

 

 
 

 
13. You will be presented with a new Fax Message that can now be 

addressed and sent.  
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Fax Annotation 

1. To annotate a fax, Click on the Annotation menu. 
 

 
 

 

2. The Annotation toolbar will be displayed. You can add stamps, lines, 
highlights etc to your Fax using the options. 

 

      
 
 
3. To record your Fax or add recorded audio to it. Simply click on the 

Telephone Icon as previously covered. 
 

 
 

4. Once recorded, the voice file attaches to your message. Click on the 
Send icon once completed. 
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Viewing a Fax Message 

 

To view a Fax message: 
 

1. Double click on the Fax Message within your CallPilot Message Store. 
 

 
 
 

2. The fax message opens in .tif format (with your audio also attached). 
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Changing Your Default Audio Device and Telephone 
Number 

You may wish to change the default audio device to utilse message playback 
for example, from a PC configured with speakers. If message playback from a 
telephone is required the DN of the telephone to be used can also be set. 
 

1. Within Outlook select the Tools menu, and then select the CallPilot 
Desktop Messaging option. Click on Configuration. 

 

            
 

2. Select the Audio tab. 
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3. You can select either the Telephone or Computer as the Audio Device. 
 

        
 

To change the default telephone number that CallPilot dials to play your voice 
messages: 
 

1. Make sure that Telephone is selected as your audio device on the 
Audio tab. 

 
2. Then change the telephone number before clicking on OK to save the 

changes. 
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Downloading the Address Book 

The CallPilot Address Book contains the names and addresses of all users on 
your local CallPilot server. You cannot edit this list. To use the CallPilot 
Address Book, download it to your computer. 
 

1. Within Outlook select the Tools menu. 
 
2. Select CallPilot Desktop Messaging and click on Configuration. 
 

            
 
 

3. Click the Address Book tab. 
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4. To refresh the list on a regular basis, check the Remind me… box and 

enter the number of days between reminders. 
 

5. Click Download now.  

 
6. The CallPilot Address Book will be downloaded. 

 
7. Click OK.  

Changing your CallPilot Password 

You can change your CallPilot password from Desktop Messaging or from the 
telephone. 
 

1. Within Outlook select the Tools menu. 
 
2. Select CallPilot Desktop Messaging and click on Configuration. 
 

            
 
 Or, on later versions of Outlook 
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3. Click the Change Password button. 

 

           
 
4. Enter your old password in the Old Password box. 

 
5. Enter your new password in New Password box. 

 
6. Validate your new password by entering it in the Validate Password 

box. 
 

7. Click OK. 

 
8. You will be informed that your password has been changed. 
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Troubleshooting Tips 

Before you install Unified Messaging, make sure the email client is working 
properly. 

Voice Format for Business Communications Manager  

BCM uses the G711 format to record and store voice messages. 
CallPilot 150 uses G723.1. Unified Messaging player records and plays 
messages in WAV format, hence BCM or CallPilot messages must be 
converted to WAV before being played. Any composed messages must be 
converted to G711 or G723.1 if they are to be stored on the BCM or within the 
CallPilot application. This decoding and encoding is done on the desktop 
client. 

Troubleshooting Log on Problems - Invalid credentials 

The subscriber sees messages such as “Invalid credentials. Please retry” or 
“The server could not be located. Please Retry.” 
 
On the subscriber‟s computer, check that Unified Messaging is configured 
with the proper settings. Verify that the following information is correct: 
 

1. Mailbox number. 
 
2. Fully qualified domain name (FQDN) or IP address of the Business 

Communications Manager system. 
 

3. The SMTP/VPIM prefix of the Business Communications Manager 
system if Message Networking is configured. 

 
4. Check that you can log on from the telephone using the same mailbox 

number and password. 
 

5. Verify that you have network connectivity to the Business 
Communications Manager system. 

 
a. For example, issue a network command to the Business 

Communications Manager system, exactly as it appears in your 
Unified Messaging configuration.  

 
b. Try to ping using the DOS prompt, and ensure that you receive 

a valid response from the Business Communications Manager.  
 

c. If you do not have network connectivity to the Business 
Communications Manager system, you are not able to access 
Unified Messaging. 
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Troubleshooting after Logging on 

The Subscriber Cannot Send a CallPilot Message 

 
The subscriber cannot send a CallPilot message. When the subscriber clicks 
Send, an error message appears that says, “Error. Failed to send message.” 
 
Ask the subscriber to check that their mailbox is not full. If their mailbox is full, 
they cannot send messages until some messages are deleted. 
 

Non-delivery Notification 

 
The subscriber receives non-delivery notifications for messages. 

 
1. Ask the subscriber to make sure that their mailbox is not full. 

 
2. Ask the subscriber to make sure that they are addressing the message 

correctly. See “Address Formats” in the online Help. 
 

3. Ask the subscriber to ensure that they are attaching only TIFF-F, VBK, 
WAV, or TXT files to messages. Unified Messaging does not accept 
any other file types. 

 
4. If the subscriber is sending to a remote location, ask the subscriber to 

verify that the address is valid and still exists. 
 

5. For fax machines, ensure that the fax number is valid and the machine 
is accepting faxes. 

 
6. Ensure that the subscriber has the capability to dial the number. Refer 

to the CallPilot Manager Set Up and Operation Guide. 
 

7. Verify that the remote server is responding by issuing a network 
command on the Business Communications Manager system.  

 
8. Internet Mail clients cannot send or receive WAV files. 
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"Unknown" Appears in the Sender Field 

In some messages, the subscriber sees a name or phone number in the 
Sender field. In other messages, the subscriber sees “Unknown”. 
 
If the caller‟s phone system has Calling Line ID, CLID information appears in 
the Sender field for messages that are created when people phone you and 
you are not available.  
 
If CLID information is not provided, it appears as “Unknown”.  
 
For messages that are sent from people using Networking, if the sender‟s 
name is not provided to the CallPilot system, the Sender field appears as 
“Unknown”. 
 

The Subscriber has Problems with Fax Reception 

People do not receive faxes sent by the subscriber, or the subscriber does not 
receive faxes sent to them. 
 

1. Verify that the subscriber has a mailbox Class of Service with fax 
capability. 

 
2. Make sure that the potential recipient of the fax can receive faxes.  

 

Messages no Longer on Server 

The subscriber receives the error message: “This message could not be found 
on the server. Messages must exist on the server in order to be played via the 
telephone. Use computer to play this file. Port failed.” 
 
Voice messages that are saved to the subscriber‟s computer are no longer in 
their CallPilot Inbox. 
 
The subscriber cannot play these messages from the telephone. To listen to 
these messages, the subscriber must use computer speakers or headphones. 
 
 
 
 
 
 
 
 
 
 
 
 



CallPilot Unified Messaging 

NN40011-019 Issue 1.2 BCM Rls 6.0  55 

Windows Vista Mail Purge Messages Fail Due to Microsoft 
Limitations 

 
To keep and show deleted messages in your Inbox 
 

1. From the menu bar, navigate to Tools > Options > Advanced. 
 
2. Select the Use the Deleted Items Folder with IMAP accounts. 
 
3. Deleted items remain in your Inbox. 
 
4. While in your Inbox, navigate to View > Current View. 

 
5. Select the Show Deleted Messages check box. 

 
6. Deleted items are shown in your Inbox. 
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Avaya Documentation Links 

 Unified Messaging Configuration guide 

 Desktop Messaging User guide for Novell GroupWise 

 Desktop Messaging User guide for Internet Clients 

 Desktop Messaging User guide for Lotus Notes 

 Desktop Messaging User guide for Microsoft Outlook 

 Updates to the Desktop Messaging User Guides 
 
 


